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ВВЕДЕНИЕ 
 

Программный комплекс MATLAB поставляется вместе с пакетом 
расширения Simulink, предназначенным для моделирования динами-
ческих систем, модели которых составляются из отдельных блоков 
(компонентов). 

Пакет Simulink является ядром интерактивного программного 
комплекса, предназначенного для математического моделирования 
линейных и нелинейных динамических систем и устройств, представ-
ленных своей функциональной блок-схемой, именуемой S-моделью, 
или просто моделью. В данном пакете реализованы принципы визу-
ально ориентированного программирования, что позволяет легко на-
бирать нужные блоки и соединять их с целью составления модели 
системы или устройства. При этом сложнейшие уравнения состояния, 
описывающие работу моделей систем или устройств, формируются 
автоматически без участия пользователя, что значительно облегчает и 
ускоряет его работу. 

Для построения функциональной блок-схемы моделируемых уст-
ройств Simulink имеет обширную библиотеку блочных компонентов и 
удобный редактор блок-схем. Simulink автоматизирует следующий, 
наиболее трудоемкий этап моделирования: он составляет и решает 
сложные системы алгебраических и дифференциальных уравнений, 
описывающих заданную функциональную схему (модель), обеспечи-
вая удобный и наглядный визуальный контроль над поведением соз-
данного пользователем виртуального устройства. 

Данные методические указания предназначены для проведения 
лабораторных работ студентами, обучающимися по специальностям 
140607 – «Электрооборудование автомобилей и тракторов», 190201 – 
«Автомобиле- и тракторостроение», 190205 – «Подъемно-
транспортные, строительные, дорожные машины и оборудование», 
190603 – «Сервис транспортных и технологических машин и обору-
дования (нефтегазодобыча)», 220301 – «Автоматизация технологиче-
ских процессов и производств (строительство)», и служат для изуче-
ния различных характеристик автоматических систем управления. 

Целью проведения данных лабораторных работ является 
получение навыков математического моделирования и исследования 
основных типов ЗТМ в программном продукте Matlab-Simulink. 
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ОСНОВЫ МОДЕЛИРОВАНИЯ В СРЕДЕ SIMULINK 
 

Структура приложения 
 

Для запуска пакета Simulink необходимо нажать кнопку Simulink 
в панели инструментов главного окна системы MATLAB. При нажа-
тии этой кнопки открывается окно браузера библиотек (рис. 1). Окно 
браузера библиотек состоит из шести основных частей: 

1) командное меню; 
2) панель инструментов; 
3) поле информационных сообщений; 
4) окно разделов библиотеки; 
5) окно с входящими в эти разделы подразделами или блоками; 
6) строка состояния. 

 
В окне браузера содержится дерево компонентов библиотек 

Simulink. Для просмотра того или иного раздела библиотеки доста-
точно выделить его нажатием левой кнопки мыши, и в правой части 

Рис. 1. Окно браузера библиотек Simulink 

1 2 3 

4 

5 

6 
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окна Simulink Browser Library появится набор пиктограмм компонен-
тов активного раздела библиотеки. 

 
Разделы библиотеки Simulink 

 
Continuous – раздел непрерывных блоков. 
В состав раздела непрерывных блоков входят (рис. 2): 
 Derivative – дифференцирующий блок; 
 Integrator – интегрирующий блок; 
 State-Space – линейная аналоговая система, заданная в виде 

уравнений состояния, т. е. в виде системы уравнений, представленной 
в форме Коши; 

 Transfer Fcn – блок, реализующий передаточную функцию, за-
данную в виде отношения полиномов (апериодическое или колеба-
тельное звено); 

 Transport Delay – блок постоянного запаздывания; 
 Variable Transport Delay – блок памяти с переменной задержкой; 
 Zero-Pole – линейная аналоговая система, заданная своими ну-

лями и полюсами. 

 
Math Operations – раздел математических блоков. 
В состав раздела математических блоков входят (рис. 3): 
 Abs – блок, формирующий на выходе абсолютное значение 

входного сигнала; 
 Add – блок скалярного, векторного или матричного сложения; 
 Bias – блок, добавляющий скалярную величину к входному 

сигналу; 
 Complex to Real-Image, Real-Image to Complex – блоки, преоб-

разующие комплексные величины из показательной формы в алгеб-
раическую и обратно; 

 Divide – блок скалярного, векторного или матричного деления; 
 Dot Product – звено, осуществляющее перемножение двух 

Рис. 2. Блоки раздела Continuous 



7 

входных величин, если они являются скалярами. Это звено вычисляет 
также сумму поэлементных произведений двух входных векторов 
одинаковой длины; 

 Gain – усилительный блок; 
 Magnitude-Angle to Complex – блок, преобразующий входную 

величину, заданную модулем и фазой, в комплексную выходную ве-
личину; 

 Mat Function – блок, позволяющий выбрать одну из математи-
ческих функций в поле настройки и включить ее в модель; 

 MinMax – блок выбирает минимальное или максимальное зна-
чение вектора в соответствии с заданием поля настройки. Входной 
сигнал на блок задается числовым вектором. В окне настройки опре-
деляется также количество входов; 

 Product – вычислитель, формирующий на выходе результат ум-
ножения или деления двух и более входных сигналов. В качестве па-
раметров настройки указывается число входов и вид выполняемой 
операции; 

 Product of Elements – матричное умножение; 
 Reshape – блок, изменяющий размерность матриц; 
 Rounding Function – округление входного сигнала; 
 Sign – блок-реле, реагирующий на знак входного сигнала; 
 Sine Wave Function – блок, генерирующий синусоидальный 

сигнал в зависимости от входного сигнала времени; 
 Slider Gain – аналоговый усилитель с интерактивной настройкой; 
 Squeeze – блок, убирающий единичную размерность из матриц; 
 Substract – блок вычитания; 
 Sum – сумматор сигналов с различными знаками и любым ко-

личеством входов; 
 Sum of Elements – матричное сложение; 
 Trigonometric Function – звено формирования тригонометриче-

ских функций от входного сигнала. Выбор функции обеспечивается в 
поле настройки; 

 Unary Minus – блок, изменяющий знак сигнала; 
 Vector Concatenate – блок, образующий вектор из двух входных 

величин; 
 Weighted Sample Time Math – блок, добавляющий к входному 

сигналу постоянную времени; 
 Polynomial – блок, реализующий полиномиальную функцию. 
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Discontinuities – раздел нелинейных блоков. 
В состав раздела нелинейных блоков входят (рис. 4): 
 Backlash – блок люфта; 
 Coulomb and Viscous Friction – блок фрикционных эффектов; 
 Dead Zone – блок с зоной нечувствительности; 
 Dead Zone Dynamic– блок с переменной зоной нечувствитель-

ности; 
 Hit Crossing – блок, детектирующий пересечение входного 

сигнала с заданной настройкой; 
 Wrap To Zero – блок, выдающий ноль, если входной сигнал 

меньше заданного условия; 
 Rate Limiter – блок с ограничением скорости; 
 Rate Limiter Dynamic – блок с переменным ограничением ско-

рости; 
 Relay – релейный блок; 
 Saturation – блок ограничения; 
 Saturation Dynamic – блок переменного ограничения; 
 Quantizer – блок, обеспечивающий квантование входного сиг-

нала по уровню. В системах управления такие блоки являются частью 
аналого-цифрового преобразователя. 

Рис. 3. Блоки раздела Math Operations 
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Sources – раздел блоков источников сигналов. 
В состав раздела источников сигнала блоков входят (рис. 5): 
 Band-Limited White Noice – генератор белого шума; 
 Chrip Signal – генератор сигнала с нарастающей частотой; 
 Constant  источник постоянного воздействия, задающий кон-

станту; 
 Discrete Pulse Generator – источник дискретных импульсов; 
 From File и From Workspace  источником сигнала для этих 

блоков служит файл или рабочая область MATLAB; 
 Ramp – источник нарастающего воздействия; 
 Random Number – источник случайного сигнала с нормальным 

распределением; 
 Repeating Sequence – источник пилообразного сигнала; 
 Sine Wave – источник синусоидального воздействия; 
 Step – источник перепада сигнала; 
 Signal Generator – универсальный сигнал-генератор; 
 Clock – источник времени моделирования; 
 Digital Clock – цифровой источник времени. 
Sinks – раздел блоков получателей сигналов. 
В состав раздела получателей сигнала блоков входят (рис. 6): 
 Display – блок, отображающий цифровую информацию (уро-

вень сигнала в данный момент времени); 
 Scope – виртуальный осциллограф, предназначенный для полу-

чения временных зависимостей (переходных процессов); 
 Stop Simulink – остановка симуляции; 
 To File – блок, передающий выходной сигнал в другую модель; 
 To Workspace – блок, передающий информацию в рабочую об-

ласть MATLAB; 

Рис. 4. Блоки раздела Discontinuities 
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 XY Graph – виртуальный графопостроитель (построение фазо-
вых портретов и различных двухмерных графиков). 

 
 

Создание и исследование модели в программном 
пакете Simulink 

 
Для создания окна новой модели нужно нажать кнопку «Create a 

new model» (см. рис. 1) в панели инструментов браузера библиотек 
Simulink либо выполнить соответствующую команду из командного 
меню. Окно модели имеет собственную панель инструментов, содер-
жащую командное меню и панель инструментов, с помощью которых 
осуществляются управление, редактирование, навигация в модели, а 
также другие функции. 

Размещение блоков в окне модели производим перетаскиванием 
блока в окно модели, удерживая левую кнопку мыши, либо, нажав 
правую клавишу мыши на нужном нам блоке в библиотеке, выбираем 
в контекстном меню команду «Add to ‘имя модели’». В окне модели 

Рис. 6. Блоки раздела Sinks 

Рис. 5. Блоки раздела Sources 
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должна появиться пиктограмма этого блока. Окно модификации па-
раметров блока вызывается двойным щелчком мыши либо выбором в 
контекстном меню команды «Block parameters». 

Соединение блоков между собой производится с помощью мы-
ши. Блоки моделей имеют входы и (или) выходы. Для этого курсор 
мыши устанавливается на выходе блока, от которого должно исхо-
дить соединение. Держа нажатой левую кнопку мыши, надо плавно 
переместить курсор к входу следующего блока. Ответвление от уже 
созданных линий производится при помощи зажатой правой клавиши 
мыши в точке необходимого отвода. 

Для вставки модели в различные текстовые или графические ре-
дакторы необходимо выполнить команду «Edit > Copy model to 
clipboard» – модель скопируется в виде картинки в буфер обмена ОС 
Windows и может быть вставлена в любой текстовый или графиче-
ский редактор. 

Любая модель, создаваемая в пакете Simulink, должна состоять из 
трех основных частей: 

1)  источник сигнала; 
2)  модель, состоящая из совокупности различных блоков; 
3)  приемник сигнала. 
Для примера составим простейшую модель, состоящую из источ-

ника единичного ступенчатого воздействия (блок Constant из раздела 
Sources), апериодического звена (блок Transfer Fcn из раздела 
Continuous) и виртуального осциллографа (блок Scope из раздела 
Sinks). Составленная модель представлена на рис. 7. 

 
После запуска модели, нажав соответствующую кнопку на па-

нели инструментов, можно посмотреть результат моделирования в 
виртуальном осциллографе, открыв его двойным щелчком мыши. На 
рис. 8 представлено окно осциллографа с полученным переходным 
процессом апериодического звена. 

Рис. 7. Общий вид модели Simulink 
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В окне виртуального осциллографа (см. рис. 8) можно выделить 

две области: окно осциллографа и панель инструментов, с помощью 
которой настраивается вид окна, а также внутренние свойства данно-
го блока. 

Специально для построения переходных процессов и частотных 
характеристик линейных систем, а также определения их показателей 
служит дополнение к пакету Simulink – LTI Viewer. 

 

Рис. 8. Окно виртуального осциллографа 

Рис. 9. Задание входных и выходных точек в модели Simulink 
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Для получения линейных характеристик системы необходимо за-
дать точки входа и выхода для линеаризации: «Input point» и «Output 
point». Данные точки задаются нажатием правой кнопки мыши на со-
ответствующей линии и выбором в контекстном меню Linearization 
Points нужного пункта, как показано на рис. 9. 

Для получения переходных и частотных характеристик в пакете 
Simulink с помощью LTI Viewer необходимо выполнить следующие 
действия: 

1. Выполнить команду меню Tools > Control Design > Linear 
Analysis, после чего появится окно менеджера Control and Estimation 
Tools Manager (рис. 10), в котором показываются активные точки, 
кнопка запуска линеаризации «Linearize Model» и окно выбора типа 
характеристик. 

2. Выбрать нужную характеристику и нажать кнопку «Linearize 
Model», после чего на экран выводится окно LTI Viewer с построен-
ным графиком. 

 
Для получения переходного процесса в окне типа характеристик 

Control and Estimation Tools Manager выбирается «step response plot», 
после чего производится запуск линеаризации и выводится окно LTI 
Viewer с полученным графиком (рис. 11). 

 
Переходный процесс системы 

 
Все показатели переходного процесса в пакете расширения LTI 

Viewer получают с помощью нажатия правой кнопки на графике пе-
реходного процесса и выбора пункта контекстного меню 
Characteristics > *** (см. рис. 11). 

Рис. 10. Окно Control and Estimation Tools Manager 
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Из наиболее часто использующихся показателей качества пере-
ходного процесса в LTI Viewer можно получить: 

 Время регулирования (пункт Settling Time) – интервал времени, 
по истечении которого отклонение переходной характеристики от ус-
тановившегося значения не превышает некоторой заданной величи-
ны. Обычно отклонение управляемой величины от установившегося 
значения должно быть не более 5%. В пакете расширения LTI Viewer 
по умолчанию установлено отклонение от заданной величины 2%. 
Для того чтобы изменить это значение, необходимо в командном ме-
ню LTI Viewer в пункте Edit выбрать «Viewer Preferences». На заклад-
ке Options открывшегося окна установить значение «Show settling 
time within», равное 5%. 

 Перерегулирование (пункт Peak Response) – максимальное от-
клонение управляемой величины от установившегося значения, вы-
раженное в процентах, характеризует колебательность переходного 
процесса. При выборе пункта Peak Response появляется окошко со 
следующими числовыми значениями: 

- Peak amplitude – максимальное значение выходного сигнала 
ymax; 

- Overshoot – перерегулирование σ, %; 
- At time – время, при котором зафиксировано максимальное 

значение выходного сигнала. 

 Рис. 11. Переходный процесс с показателями качества 
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 Установившееся значение выходного сигнала yуст, определяю-
щее статическую точность системы. Установившееся значение опре-
деляется в LTI Viewer с помощью пункта меню Characteristics > 
Steady State (см. рис. 11). 

 
Частотные характеристики системы 

 
В пакете LTI Viewer приложения Simulink численные значения за-

пасов устойчивости системы автоматического управления можно оп-
ределить по ЛЧХ (логарифмические частотные характеристики ЛАХ и 
ЛФХ) или АФЧХ (амплитудно-фазовая частотная характеристика).  

Для получения частотных характеристик в окне типа характери-
стик Control and Estimation Tools Manager выбирается «Bode response 
plot» или «Nyquist plot» для ЛАХ и ЛФХ или АФЧХ соответственно. 
Также необходимо поставить галочку «Open Loop» на активной точке 
выхода «Output point», так как логарифмические характеристики 
строятся только для разомкнутых систем, после чего производится 
запуск линеаризации и выводится окно LTI Viewer с полученным 
графиком (рис. 12 и 13). 

В случае применения частотных критериев имеется два показате-
ля устойчивости: 

 запас устойчивости по амплитуде L (Gain Margin), измеряемый 
в децибелах (дБ) и показывающий, на сколько следует сдвинуть ЛАХ, 
чтобы система оказалась на границе устойчивости (см. рис. 12 и 13); 

 запас устойчивости по фазе  (Phase Margin), измеряемый в 
градусах и показывающий, на сколько следует сдвинуть ЛФХ, чтобы 
система оказалась на границе устойчивости (см. рис. 12 и13). 

Для определения запасов устойчивости необходимо щелкнуть 
правой кнопкой мыши на поле графика и выбрать пункт контекстного 
меню Characteristics > Stability Margins (Min). Для получения числен-
ных значений запасов устойчивости необходимо нажать курсором на 
выделенных точках. Кроме того, делается вывод об устойчивости 
замкнутой системы: Closed-loop stable? (Замкнутая система устойчи-
ва?), который может принимать два значения: Yes (Да) и No (Нет). 

Таким образом, для проведения исследования модели необхо-
димо и достаточно определить показатели качества переходного про-
цесса, устойчивость и её запасы по частотным характеристикам, а 
также сравнить их с предельными показателями устойчивости и каче-
ства, заданными для данной модели. 
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 Рис. 13. АФЧХ с показателями устойчивости 

Рис. 12. ЛАХ ЛФХ с показателями устойчивости 
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Редактирование и сохранение полученных результатов 
 

После получения нужных характеристик возникает необходи-
мость редактирования (подпись точек и осей, выбор масштаба или 
изменение градуировки и т.д.) и сохранения данных. В этом случае 
следует воспользоваться командой File > Print to Figure в командном 
меню окна LTI Viewer. После использования данной команды появля-
ется окно редактирования графических объектов Figure, представлен-
ное на рис. 14. 

 

 
 
Данный инструмент имеет собственное командное меню и пре-

доставляет расширенные возможности редактирования полученных 
графиков, а также экспорт результатов в виде растровых изображе-
ний. Также его можно использовать для построения графических за-
висимостей массивов данных, полученных в результате исследования 
модели и хранящихся в рабочей области Matlab – Workspace. 

Таким образом, программный пакет Simulink является закон-
ченным программным продуктом, позволяющим производить визу-
альное моделирование, исследование построенных моделей и вывод 
результатов в числовом и графическом виде. 

Рис. 14. Внешний вид окна Figure 
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Лабораторная работа №1 
 

ИССЛЕДОВАНИЕ ТИПОВЫХ ДИНАМИЧЕСКИХ ЗВЕНЬЕВ 
 

Цель работы  изучить характеристики типовых динамических 
звеньев. 

В теории автоматического регулирования можно выделить ос-
новные типовые динамические звенья: звено постоянного запаздыва-
ния, идеальное усилительное (пропорциональное), апериодическое 
(инерционное), дифференцирующее, интегрирующее, колебательное. 

Частотные характеристики звеньев. Если на вход динамиче-
ского звена поступает сигнал синусоидальной формы определенной 
частоты, то выходной сигнал имеет те же синусоидальную форму и 
частоту, но другие амплитуду и фазу. В связи с этим различают ам-
плитудно-частотные и фазово-частотные характеристики звеньев. 
Амплитудно-частотная характеристика выражает отношение ампли-
туды колебаний  на выходе звена к амплитуде  колебаний  на  его 
входе  в зависимости  от частоты  выходного сигнала: 

Α(ω) = Авых /Авх = f(), (2.1) 
где Авых – амплитуда выходного сигнала; Авх – амплитуда входного 
сигнала; ω – угловая частота. 

Фазово-частотная характеристика выражает зависимость разно-
сти фаз между входными и выходными колебаниями звена от частоты 
входного сигнала: 

φ = f(ω), (2.2) 
где  – фазовый угол. 

Опережению фазы соответствует φ > 0, а отставанию –  < 0. 
Амплитудно-фазовую характеристику W(jω) можно рассматри-

вать как одну из форм записи передаточных функций для случая си-
нусоидального воздействия на вход звена. Для получения W(jω) из 
передаточной функции W(р) необходимо p заменить на jω. 

Логарифмической амплитудно-частотной характеристикой 
(ЛАХ) L(ω) называют зависимость модуля частотной характеристики 
от частоты, представленную в логарифмическом масштабе. 

Логарифмической фазово-частотной характеристикой (ЛФХ) на-
зывают зависимость аргумента частотной характеристики от лога-
рифма частоты. Амплитудно-фазовая частотная характеристика 
(АФЧХ) объединяет амплитудную и фазовую частотные характери-
стики. 
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Звено постоянного запаздывания 

Для любого устройства, служащего для передачи информации, 
справедливо то, что выходная величина проявляется с некоторым за-
паздыванием на время  относительно момента поступления инфор-
мации на вход устройства. В ряде случаев это время настолько мало, 
что им пренебрегают и считают, что практически информация на вхо-
де и выходе возникает в один и тот же момент. 

Звено определяется как запаздывающее, если оно описывается 
уравнением 

y(t) = x( t– ), (2.3) 
где   – время запаздывания. 

Передаточная функция звена запаздывания 
pepW )( . (2.4) 

Переходный процесс звена запаздывания рекомендуется смотреть 
в модуле Scope (двойной щелчок на пиктограмме). Для изучения 
свойств звена запаздывания необходимо изменить его параметры в 
соответствии с табл. 1 и проследить влияние изменения на переход-
ную характеристику, ЛАХ, ЛФХ и АФЧХ. Для изменения параметров 
звена необходимо сделать двойной щелчок левой кнопкой мыши по 
элементу Transport Delay в окне модели и в открывшемся окне в поле 
Time delay (время запаздывания) ввести значение из табл. 1. Параметр 
Pade order (for linearization) = 2. 

Таблица 1 
 

Значения коэффициентов звена запаздывания 
 

Параметр 1 2 3 
, с 1 2 3 

 
Идеальное усилительное звено 

 
Идеальным усилительным (пропорциональным) называют звено, 

у которого выходная величина в каждый момент времени пропорцио-
нальна входной величине. 

Уравнение идеального усилительного звена имеет вид 
у = kx. (2.5) 

где k – коэффициент передачи звена, значения для исследования при-
ведены в табл. 2. 
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Передаточная функция идеального усилительного звена 

k
pX
pYpW 

)(
)()( . (2.6) 

 
Таблица 2 

 
Значения коэффициентов идеального усилительного звена 

 
Параметр 1 2 3 
k 0,1 1 2 

Дифференцирующее звено 

Дифференцирующим называют звено, в котором выходная вели-
чина пропорциональна производной во времени от входной величи-
ны. В дифференцирующем звене выходная величина пропорциональ-
на скорости изменения входной величины.  

Уравнение дифференцирующего звена имеет вид 
у = k dx/dt. (2.7) 

При подаче на вход звена ступенчатого сигнала на выходе полу-
чается мгновенный выходной импульс, теоретически имеющий бес-
конечно большую амплитуду, соответствующую бесконечно большой 
скорости входного сигнала в момент подачи. 

Передаточная функция дифференцирующего звена 

kp
pX
pYpW 

)(
)()( . (2.8) 

Модель звена составляется из блока Switched derivative for lineariza-
tion (из раздела Linearization библиотеки Simulink Extras). Логарифми-
ческие характеристики можно считать достоверными на интервале от 
ноля до частоты, на два порядка меньшей, чем значение Derivative con-
stant. Рекомендуется установить значение Derivative constant равным 
107, тогда график достоверен на интервале до 105. Параметр Switch value 
необходимо установить равным 1 – for linearization. Значения коэффи-
циента усиления дифференцирующего звена приведены в табл. 3. 

 
Таблица 3 

 
Значения коэффициентов дифференцирующего звена 

 
Параметр 1 2 3 
k 0,1 1 4 
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Интегрирующее (астатическое) звено 

Интегрирующим называют звено, в котором выходная величина 
пропорциональна интегралу во времени от входной величины. 

Уравнение интегрирующего звена имеет вид 


t
xdtky

0
. (2.9) 

В интегрирующем звене скорость изменения выходной величины 
пропорциональна входной величине. Значения коэффициента усиле-
ния интегрирующего звена приведены в табл. 4. 

Передаточная функция интегрирующего звена 

p
k

pX
pYpW 

)(
)()( . (2.10) 

Таблица 4 
 

Значения коэффициентов интегрирующего звена 
 

Параметр 1 2 3 
k 0,1 1 3 

Апериодическое звено 

Апериодическим (инерционным) называют звено, в котором при 
подаче на вход ступенчатого сигнала выходная величина апериодиче-
ски (по экспоненте) стремится к новому установившемуся значению. 

Уравнение апериодического звена имеет вид 
Tdy/dt + у = kx. (2.11) 

где Т – постоянная времени звена, характеризующая инерционность 
звена; k – коэффициент усиления звена. 

Передаточная функция апериодического звена 

1)(
)()(




Tp
k

pX
pYpW . (2.12) 

Для изменения параметров звена необходимо сделать двойной 
щелчок левой кнопкой мыши по элементу Transfer Fcn в окне модели. 
В открывшемся окне отображены текущие параметры: в поле Numera-
tor (числитель) значение задано одним коэффициентом (который со-
ответствует коэффициенту усиления звена), а в поле Denominator 
(знаменатель) – двумя коэффициентами. По умолчанию значения всех 
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коэффициентов блока равны единице. Второй коэффициент в поле 
Denominator окна параметров блока Transfer Fcn соответствует нуле-
вой степени многочлена, находящегося в знаменателе функции, а 
первый – первой степени многочлена. Так как знаменатель переда-
точной функции апериодического звена имеет вид (Tp + 1), то второй 
(правый) коэффициент в поле Denominator изменять не следует. Зна-
чения коэффициентов изменяют в соответствии с табл. 5. 

 
Таблица 5 

 
Значения коэффициентов апериодического звена 

 
Параметр 1 2 3 
k 1 
Т 0,1 1 4 

Колебательное (апериодическое 2-го порядка) звено 

Колебательным называют звено, у которого при ступенчатом из-
менении входной величины выходная величина стремится к новому 
установившемуся значению, совершая при этом колебания. 

Передаточная функция колебательного звена 

1
1)(

2
22

1 


pTpT
pW . (2.13) 

Если параметр звена   1 ( = Т2 / 2Т1), то получают апериодиче-
ское звено 2-го порядка. 

Для изменения параметров звена необходимо сделать двойной 
щелчок левой кнопкой мыши по элементу Transfer Fcn в окне модели. 
В поле Numerator (числитель) значение задано одним коэффициентом 
(коэффициент усиления звена), а в поле Denominator (знаменатель) – 
тремя коэффициентами. Значения коэффициентов в полях Numerator 
и Denominator изменяют в соответствии с табл. 6 и оценивают влия-
ние изменения на переходную характеристику, ЛАХ, ЛФХ и АФЧХ. 

 
Таблица 6 

 
Значения коэффициентов апериодического звена 

 
Параметр 1 2 3 
k 1 
Т1 1 
Т2 1 2 4 
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Порядок выполнения работы: 
1. Составить в обозначениях Simulink структурную схему для 

снятия характеристик типовых динамических звеньев. 
2.  Получить переходную (временную), частотные (ЛАХ и ЛФХ) 

и амплитудно-фазовую частотную характеристики (АФЧХ) звеньев 
при воздействии g=1(t).  

3. Исследовать звенья: 
 Звено постоянного запаздывания Transport Delay. 
 Идеальное усилительное звено Gain. 
 Дифференцирующее звено Switched derivative for linearization. 
 Интегрирующее (астатическое) звено Integrator. 
 Апериодическое звено Transfer Fcn. 
 Колебательное звено Transfer Fcn. 
4. Составить отчет по проделанной работе. 
 
Содержание отсчета: 
Для всех шести исследуемых типовых динамических звеньев не-

обходимы следующие данные: 
 Название типового звена. 
 Картинка звена (из модели > Edit > Copy Model To Clipboard). 
 Передаточная функция звена: Формула (W(p) = f(p)). 
 Переходные характеристики звеньев: 

Картинка (из LTI > File > Print to Figure > File > Save As…). 
 Частотные характеристики (ЛАХ и ЛФХ): 

Картинка (из LTI > File > Print to Figure > File > Save As…). 
 Амплитудно-фазовые частотные характеристики:  

Картинка (из LTI > File > Print to Figure > File > Save As…). 
 

Контрольные вопросы 
 

1. Какие типовые динамические звенья исследовались в данной 
работе? Назовите передаточные функции данных звеньев. 

2. Что такое переходный процесс? 
3. Что такое ЛАХ, ЛФХ и АФЧХ? 
4. Какой вид переходного процесса соответствует каждому звену? 
5. Каково влияние коэффициентов звеньев на их переходный 

процесс? 
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Лабораторная работа №2 
 

ИССЛЕДОВАНИЕ СЛЕДЯЩЕЙ СИСТЕМЫ УПРАВЛЕНИЯ 
 

Цель работы  изучить следящую систему управления. 
 
Устройство системы. На рис. 15 изображена функциональная 

схема следящей системы. Система предназначена для воспроизведения  
исполнительным устройством управляющих сигналов g, поступающих 
на командную ось. Она состоит из сельсинной пары С1 и С2, работаю-
щей в трансформаторном режиме, фазочувствительного магнитного 
усилителя МУ; электромашинного усилителя ЭМУ с обмотками управ-
ления ОУ1 и ОУ2; исполнительного электродвигателя постоянного тока 
ИД; механической передачи МП и объекта управления О. 

 
Работа системы. Если командная ось поворачивается на некото-

рый угол g, то происходит рассогласование роторов сельсинов С1 и С2 
и на входе МУ появляется сигнал U1, пропорциональный рассогласо-
ванию  (в пределах малых углов рассогласования). Вслед за этим по-
является напряжение U2 на выходе МУ и Э.Д.С. ES на продольных 
щетках ЭМУ. Двигатель начинает вращаться, изменяются углы пово-
рота его вала 1, а также ротора сельсина приемника 2. Схема соеди-
нена так, что знак 2 противоположен знаку g (отрицательная главная 
обратная связь). Когда эти углы сравняются, исчезнет напряжение U1, 
а за ним исчезнут и последующие сигналы, тогда двигатель остано-
вится. Исполнительная ось повернется на такой же угол, как и ко-
мандная (за счет механической передачи можно реализовать поворот 
командной и исполнительной осей на пропорциональные углы). 

Передаточные функции звеньев следящей системы: 
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Структурная схема следящей системы изображена на рис. 16. 
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Рис.16. Структурная схема следящей системы управления 
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где  – ошибка регулирования; ki – коэффициенты усиления; Ti – по-
стоянные времени; g – управляющий сигнал; U1 – входной сигнал 
МУ; U2 – напряжение на обмотках управления ОУ1, ОУ2 электрома-
шинного усилителя ЭМУ; ES – ЭДС на продольных щетках ЭМУ; 1 – 
угол поворота вала ИД; 2 – угол поворота ротора сельсина приемни-
ка; МH – момент нагрузки на валу ИД. 

 
Численные значения параметров передаточных функций: 

k1 = 0,5 B/c; k2 = 0,1; k3 = 20; k4 = 60 град/Bc; k4 = 20 град/Bc;            
k5 = 0,005; T1 = 0,001 с; T2 = 0,01 с; T3 = 0,05 с; T4 = 0,52 с; T5 = 0,01 c. 

 
Таблица 7 

Значения исследуемых параметров 

Исследуемая 
характеристика 

(показатель) 

k2 

0,1 0,3 0,5 0,7 1 3 6 10 

L, дБ         

,          

tпп, с         

σ, %         

 
Порядок выполнения работы: 
1. Составить в обозначениях Simulink структурную схему систе-

мы стабилизации на ПЭВМ. 
2. Сформировать управляющее единичное ступенчатое воздейст-

вие g = 1(t). Получить переходную (временную) характеристику сис-
темы по управляющему воздействию g = 1(t) при заданных значениях 
параметров передаточных функций. 

3. Сформировать возмущающее единичное ступенчатое воздейст-
вие МН = 1(t). Получить переходную (временную) характеристику 
системы по возмущающему воздействию МН = 1(t) при заданных зна-
чениях параметров передаточных функций. 

4. Получить переходную (временную) характеристику по управ-
ляющему g = 1(t) и возмущающему МН = 1(t) воздействиям при задан-
ных значениях параметров передаточных функций. Управляющее      
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g = 1(t) и возмущающее МН = 1(t) воздействия совместно задавать в 
структурной схеме из одного источника сигнала Constant. 

5. Для заданных численных значений параметров передаточных 
функций построить ЛАХ и ЛФХ по управляющему g = 1(t) и возму-
щающему МН = 1(t) воздействиям для разомкнутой системы. 

6. Для заданных численных значений параметров передаточных 
функций построить АФЧХ по управляющему g = 1(t) и возмущающе-
му МН = 1(t) воздействиям, и по критерию Найквиста оценить устой-
чивость системы, определить численные значения запасов устойчиво-
сти по амплитуде и фазе. 

7. Провести исследование следящей системы, варьируя k2, как 
показано в табл. 7. 

Построить графики функциональных зависимостей значений 
запасов устойчивости по амплитуде и фазе, времени переходного 
процесса и величине перерегулирования от величины k2. L = f(k2);    
 = f(k2); tпп = f(k2); σ = f(k2). 

 
Содержание отчета: 
1. Схема следящей системы. 
2. Структурная схема следящей системы. 
3. Структурная схема следящей системы в обозначениях Simulink. 
4. Переходная (временная) характеристика системы по управ-

ляющему воздействию g = 1(t) и возмущающему воздействию МН = 
=1(t) для заданных значений параметров передаточных функций. 
Численные значения показателей качества переходных процессов. 

5. ЛАХ и ЛФХ разомкнутой следящей системы по управляющему 
воздействию g = 1(t) и возмущающему воздействию МН = 1(t) для за-
данных численных значений параметров передаточных функций. 
Численные значения запасов устойчивости по амплитуде и фазе, по-
лученные по ЛАХ и ЛФХ. 

6. АФЧХ следящей системы стабилизации по управляющему воз-
действию g = 1(t) и возмущающему воздействию МН = 1(t). Оценка 
устойчивости по критерию Найквиста. 

7. Графики функциональных зависимостей значений запасов ус-
тойчивости по амплитуде и фазе, времени переходного процесса и ве-
личины перерегулирования от величины k2. 
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Контрольные вопросы 
 

1. Объяснить работу следящей системы управления по рис. 15. 
2. Дать формулировку следящей системы управления. 
3. Что является в данной следящей системе управляющим и воз-

мущающим воздействиями? 
4. Как получить переходную характеристику системы? 
5. Что такое передаточная функция звена? 
6. Что такое разомкнутая система? При решении каких задач ис-

пользуется разомкнутая система? 
7. Какие требования предъявляются к следящим системам управ-

ления? 
8. Что такое ЛАХ, ЛФХ, АФЧХ, как они строятся? 
9. Дать анализ построенных функциональных зависимостей зна-

чений запасов устойчивости по амплитуде и фазе, времени переход-
ного процесса и величины перерегулирования от величины k2. 
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Лабораторная работа №3 
 

ИССЛЕДОВАНИЕ СИСТЕМЫ СТАБИЛИЗАЦИИ УГЛОВОЙ 
СКОРОСТИ ТУРБОГЕНЕРАТОРА 

 
Цель работы  изучить систему стабилизации угловой скорости 

турбогенератора. 
 
Устройство системы. В систему (рис. 17) входят следующие 

элементы: Т – турбина (объект управления); МП – механическая пе-
редача; ЦБМ – центробежный маятник (выполняет функции датчика, 
определяющего действительную угловую скорость турбины, задатчи-
ка угловой скорости и элемента сравнения, вычисляющего ошибку 
регулирования); ГУ – гидроусилитель; ГСП – гидравлический серво-
привод; ПВК – паровпускной клапан с регулятором расхода пара; Г – 
генератор, приводимый во вращение турбиной. 

 
Работа системы. Некоторой установившейся нагрузке генерато-

ра МН соответствует определенная угловая скорость турбины зад, по-
ложение грузов ЦБМ и поршня ГСП, а также величина открытия 
ПВК. Если нагрузка уменьшится, угловая скорость турбины  возрас-
тет, грузы ЦМБ, а вместе с ними и муфта переместятся вверх (Z). Пе-
реместится и золотник ГУ (S1) и приоткроет доступ рабочей жидкости 
в верхнюю полость ГСП, поршень которого начнет перемещаться 

ГСП 

Пар 

Г  

ЦБМ 

Т 

МП 

Z 

S1 

m ГУ 

ПВК 

МН 

S2 
S 

Рис. 17. Функциональная схема системы стабилизации 
угловой скорости турбогенератора 
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вниз и прикроет ПВК, который, в свою очередь, уменьшит подачу па-
ра в турбину, вследствие чего угловая скорость турбины уменьшится. 
Одновременно из-за наличия жесткой обратной связи между ГСП и 
ГУ (рычаг, связывающий ГСП, ГУ и ЦБМ) золотник ГУ переместится 
вниз и прикроет окна ГУ, движение поршня ГСП прекратится. Систе-
ма вновь окажется в некотором установившемся режиме. Если ошиб-
ка регулирования  не равна нулю, то происходят перемещения: муф-
ты ЦБМ (z); золотника ГУ (S); поршня ГСП (m); штока ПВК, вследст-
вие чего изменяется давление пара Р на входе в турбину. Знаки пере-
мещений зависят от знака ошибки регулирования. В результате чего 
изменяется   фактическая угловая скорость вращения вала турби-
ны, и ошибка регулирования стремится к нулю (0). 

Структурная схема системы стабилизации изображена на рис. 18. 
 

 
 
Передаточные функции отдельных звеньев системы: 
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Рис. 18. Структурная схема системы стабилизации угловой 
скорости турбогенератора 
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где  – ошибка регулирования; ki – коэффициенты усиления; Ti – 
постоянные времени; Z – перемещение муфты ЦБМ; S1 – 
перемещение золотника ГУ от ЦБМ; S2 – перемещение золотника ГУ 
от ГСП; S – суммарное перемещение золотника ГУ; m – перемещение 
ПВК, пропорциональное перемещению поршня ГСП; Р – давление 
пара на входе в турбину;  – угловая скорость вращения вала 
турбины; зад – заданная угловая скорость вращения вала турбины; 
МН – момент нагрузки на валу турбины. 

 
Численные значения параметров передаточных функций: 

k1=10; k2=0,8; k3=2; k4=0,8; k5=1; k’
5=0,2; k6=0,2; T2

1=0,001 с2; T2=0,2 с; 
T3=5 с; T4=0,3 с.  

При этом всегда должно выполняться условие k2+k6=1. 
 
Порядок выполнения работы: 
1. Составить в обозначениях Simulink структурную схему систе-

мы на ПЭВМ. 
2. Сформировать управляющее единичное ступенчатое воздейст-

вие зад = 1(t). Получить переходную (временную) характеристику 
замкнутой системы по управляющему воздействию зад = 1(t) при за-
данных значениях параметров передаточных функций. 

3. Сформировать возмущающее единичное ступенчатое воздейст-
вие МН = 1(t). Получить переходную (временную) характеристику 
замкнутой системы по возмущающему воздействию МН = 1(t) при за-
данных значениях параметров передаточных функций. 

4. Получить переходную (временную) характеристику по управ-
ляющему зад = 1(t) и возмущающему МН = 1(t) воздействиям при за-
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данных значениях параметров передаточных функций. Управляющее 
за = 1(t) и возмущающее МН = 1(t) воздействия совместно задавать в 
структурной схеме из одного источника сигнала Constant. 

5. Для заданных численных значений параметров передаточных 
функций построить ЛАХ и ЛФХ по управляющему за = 1(t) и воз-
мущающему МН = 1(t) воздействиям для разомкнутой системы. 

6. Для заданных численных значений параметров передаточных 
функций построить АФЧХ по управляющему g = 1(t) и возмущающе-
му Мн = 1(t) воздействиям, и по критерию Найквиста оценить устой-
чивость системы, определить численные значения запасов устойчиво-
сти по амплитуде и фазе. 

7. Провести исследование системы стабилизации, варьируя k2, как 
показано в табл. 8 (с учетом условия k2+k6=1). Построить графики 
функциональных зависимостей значений времени переходного про-
цесса, величины перерегулирования, установившегося значения угло-
вой скорости, запасов устойчивости по амплитуде и фазе от величины 
k2. Построить графики  tпп = f(k2);  σ = f(k2);  ωуст  = f(k2);  L = f(k2)  и   
 = f(k2). 

 
Таблица 8 

Значения исследуемых параметров 

k2 0,2 0,3 0,4 0,5 0,6 0,7 0,8 

k6 0,8 0,7 0,6 0,5 0,4 0,3 0,2 

ωуст        

tпп, с        

σ, %        

L, дБ        

,         

 
Содержание отчета: 
1. Функциональная схема системы стабилизации угловой скоро-

сти турбогенератора. 
2. Структурная схема системы стабилизации угловой скорости 

турбогенератора. 



33 

3. Структурная схема системы стабилизации в обозначениях Si-
mulink. 

4. Переходная (временная) характеристика системы по управ-
ляющему зад = 1(t) и возмущающему МН = 1(t) воздействиям для за-
данных численных значений параметров передаточных функций. 
Численные значения показателей качества переходных процессов. 

5. ЛАХ и ЛФХ разомкнутой системы стабилизации для заданных 
численных значений параметров передаточных функций. 

6. АФЧХ системы стабилизации. Численные значения запасов ус-
тойчивости, полученные по АФЧХ, и оценка устойчивости по крите-
рию Найквиста. 

7. Графики функциональных зависимостей значений времени пе-
реходного процесса, величины перерегулирования, установившегося 
значения угловой скорости, запасов устойчивости по амплитуде и фа-
зе от величины k2. Построить графики tпп = f(k2); σ = f(k2); ωуст = f(k2); 
L = f(k2) и  = f(k2). 

 
Контрольные вопросы 

 
1. Объяснить работу системы по рис. 17. 
2. Объяснить принципы регулирования по отклонению. 
3. Что такое жесткая обратная связь? Принцип ее работы на схе-

мах рис. 17 и 18. 
4. Какими показателями (критериями) характеризуется качество 

переходного процесса? 
5. Как влияет увеличение МН на ? 
6. Что такое запасы устойчивости по амплитуде и фазе? Их реко-

мендуемые численные значения. 
7. Показать на ЛАХ, ЛФХ, АФЧХ значения запасов устойчивости 

по амплитуде и фазе. 
8. Сформулировать критерий Найквиста. 
9.  Дать анализ построенных функциональных зависимостей от 

величины k2. 
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Лабораторная работа №4 
 

ИССЛЕДОВАНИЕ СИСТЕМЫ АВТОМАТИЧЕСКОЙ 
СТАБИЛИЗАЦИИ НАПРЯЖЕНИЯ СИНХРОННОГО 

ГЕНЕРАТОРА 
 

Цель работы  изучить систему автоматической стабилизации 
напряжения синхронного генератора. 

 
Устройство системы. На рис. 19 изображена функциональная 

схема системы автоматической стабилизации напряжения синхронно-
го генератора с токовым компаудированием. Здесь СГ – синхронный 
генератор, объект регулирования; ОВГ – обмотка возбуждения гене-
ратора; В – возбудитель, генератор постоянного тока; ОВВ – обмотка 
возбуждения возбудителя; ПВ – подвозбудитель ЭМУ с поперечным 
полем; ОУ1 и ОУ2 – обмотки управления ЭМУ; ЛЭ и НЭ – линейный и 
нелинейный измерительные элементы; ТТ – трансформатор тока; ВП 
– выпрямитель. 

 
Работа системы. Если напряжение генератора равно заданному, 

то магнитодвижущие силы (МДС) обмоток управления ОУ1 (F1) и ОУ2 
(F2), действующие в магнитной системе ЭМУ встречно, создают 
вполне определенную результирующую МДС FР. Если напряжение по 
какой-либо причине увеличится или уменьшится, то результирующая 
МДС FР также изменит свое значение: с ростом UГ она уменьшится, а 
с падением увеличится. В первом случае это приведет к уменьшению 
напряжений U1 на выходе ЭМУ, U2 на выходе возбудителя и в конеч-
ном счете уменьшению напряжения генератора UГ. Во втором случае 
картина будет обратной. Цепь такого компаудирования с МДС FР 
предназначена для форсировки возбуждения при резких изменениях 
тока нагрузки IГ. Структурная схема системы приведена на рис. 20. 

 
Передаточные функции системы: 

   
    ;11 21
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1 


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   
  ;
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   
  ;
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3 
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pUpW Г  (5.3) 

   
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 
.

1
1

4

'
4

'
3

4 



pT
pTk

pI
pUpW

Г

Г  (5.4) 

 

 
Передаточные функции измерительного элемента по току и на-

пряжению соответственно 
  ;65 kpW   (5.5) 

Рис. 19. Функциональная схема системы автоматической 
стабилизации напряжения синхронного генератора 
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ЛЭ НЭ 
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ТТ 
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F1 F2 

Рис. 20. Структурная схема системы автоматической стабилизации 
напряжения синхронного генератора 
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  ,456 kpW   (5.6) 

где ki – коэффициенты усиления, Ti – постоянные времени; U1 – вход-
ной сигнал МУ. 

Числовые значения параметров передаточных функций: 
k1=10; k2=0,8; k3=5; k3=0,1; k45=0,05; k6=0,8; T1=0,02 c; T2=0,05 c; T3=0,1 c; 
T4= 0,2 c; T4=0,02 c. 

%100



Гзад

ГзадГуст

U
UU

 ; (5.7) 

ГзадГустст UU  . (5.8) 
 

Таблица 9 
Значения исследуемых параметров 

k6 0,825 0,85 0,875 0,9 0,925 0,95 

UГ.уст       

ст       

σ, %       

L, дБ       

,        

 
Порядок выполнения работы: 
1. Составить в обозначениях Simulink структурную схему систе-

мы на ПЭВМ. 
2. Сформировать управляющее единичное ступенчатое воздейст-

вие Uзад = 1(t). Получить переходную (временную) характеристику 
системы по управляющему воздействию Uзад = 1(t) при заданных зна-
чениях параметров передаточных функций. 

3. Сформировать возмущающее единичное ступенчатое воздейст-
вие IГ = 1(t). Получить переходную (временную) характеристику сис-
темы по возмущающему воздействию IГ = 1(t) при заданных значени-
ях параметров передаточных функций. 

4. Получить переходную (временную) характеристику системы 
по управляющему Uзад = 1(t) и возмущающему IГ = 1(t) воздействиям 
при заданных значениях параметров передаточных функций. Управ-
ляющее Uзад = 1(t) и возмущающее IГ = 1(t) воздействия совместно за-
давать в структурной схеме из одного источника сигнала Constant. 
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5. Получить ЛАХ и ЛФХ системы с запасами устойчивости по 
управляющему Uзад = 1(t) и возмущающему IГ = 1(t) воздействиям при 
заданных значениях параметров передаточных функций. 

6. Провести исследование следящей системы, варьируя k6, как по-
казано в табл. 9. Построить графики функциональной зависимости 
значений статической ошибки ст, перерегулирования и запасов ус-
тойчивости от величины k6: ст = f(k6); σ = f(k6); L = f(k2) и  = f(k2). 
Определить рациональное значение k6. 

 
Содержание отчета: 
1. Функциональная схема системы автоматической стабилизации 

напряжения синхронного генератора. 
2. Структурная схема системы автоматической стабилизации на-

пряжения. 
3. Структурная схема системы автоматической стабилизации на-

пряжения в обозначениях Simulink. 
4. Переходная характеристика, ЛАХ и ЛФХ системы по управляю-

щему воздействию Uзад = 1(t) и возмущающему воздействию IГ = 1(t) 
для заданных значений параметров передаточных функций. Численные 
значения показателей качества переходных процессов. 

5. Графики функциональной зависимости значений статической 
ошибки ст, перерегулирования и запасов устойчивости от величины 
k6: ст = f(k6); σ = f(k6); L = f(k2) и  = f(k2). Рациональное значение k6. 

 
Контрольные вопросы 

 
1. Объяснить работу системы по рис. 19. 
2. Сформулировать фундаментальные способы управления, про-

демонстрировать их на рис. 20. 
3. Дать определения показателям качества переходного процесса. 
4. Дать анализ полученным зависимостям от величины k6. 
5. Из каких соображений выбрано рациональное значение k6? 
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Лабораторная работа №5 
 

ИССЛЕДОВАНИЕ СИСТЕМЫ АВТОМАТИЧЕСКОГО 
РЕГУЛИРОВАНИЯ УГЛОВОЙ СКОРОСТИ ДВИГАТЕЛЯ 

ВНУТРЕННЕГО СГОРАНИЯ (ДИЗЕЛЯ) 
 

Цель работы  изучить систему автоматического регулирования 
(САР) угловой скорости двигателя внутреннего сгорания (дизеля). 

 
Устройство системы. На рис. 21 изображена САР угловой ско-

рости двигателя внутреннего сгорания (дизеля) с внутренней изо-
дромной обратной связью. Здесь Д – дизель; МП – механическая пе-
редача; ЦБМ – центробежный маятник; ГУ – гидроусилитель; СМ – 
сервомотор; К – катаракт; П – пружина. 

 
Работа системы. В установившемся режиме определенному 

моменту нагрузки Мн на валу дизеля соответствует некоторая подача 
топлива, зависящая от положения рейки топливного насоса Х3, кото-
рую перемещает сервомотор СМ. Если нагрузка по какой-либо при-
чине уменьшится, угловая скорость дизеля возрастет, грузы ЦБМ ра-
зойдутся и переместят муфту, а вместе с нею и золотник ГУ. Рабочая 
жидкость поступит в СМ и он начнет уменьшать подачу топлива. В 
первый момент времени вместе с поршнем СМ переместятся поршень 
и цилиндр катаракта К, обратная связь на ГУ сработает, как жесткая. 
Однако затем под влиянием пружины П цилиндр К будет переме-
щаться вверх, а жидкость в цилиндре К через отверстия в поршне пе-
ретечет из верхней полости в нижнюю. Жесткая связь между СМ и ГУ 
нарушится, движение поршня СМ прекратится лишь тогда, когда уг-
ловая скорость дизеля полностью восстановится до исходного уровня. 
Если нагрузка на валу двигателя возрастет, действие системы будет 
направлено на увеличение подачи топлива и восстановление исход-
ной скорости. 

 
Передаточные функции звеньев системы: 
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     ;''' 111 pXpXpX   (6.6) 
     ;' 43235 pXkpXkpX   (6.7) 
     ,1 pXpXp ЗАД   (6.8) 

где  – ошибка регулирования; ki – коэффициенты усиления; Ti – по-
стоянные времени; ХЗАД – заданная угловая скорость; Х1 – угловая 
скорость дизеля; Х2 – перемещение муфты ЦБМ; Х4 – перемещение 
цилиндра катаракта К; Х5 – перемещение золотника ГУ. 

 
На рис. 22 изображена структурная схема САР угловой скорости 

двигателя внутреннего сгорания (дизеля). 

CM 

ЦБМ 

X2 k5 

ГУ 

П 

X4 

Х3 

К 

X1 
МП 

Д 
МН 

Рис. 21. Функциональная схема системы автоматического регулирования 
угловой скорости двигателя внутреннего сгорания (дизеля) 
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Таблица 10 
Значения исследуемых параметров 

tпп, с σ, % 

k3 
T4 

0,01 0,03 0,05 0,07 0,09 k3 
T4 

0,01 0,03 0,05 0,07 0,09 

1      1      

1,5      1,5      

2      2      

2,5      2,5      

3      3      

L, дБ , ° 

k3 
T4 

0,01 0,03 0,05 0,07 0,09 k3 
T4 

0,01 0,03 0,05 0,07 0,09 

1      1      

1,5      1,5      

2      2      

2,5      2,5      

3      3      

Рис. 22. Структурная схема системы автоматического регулирования угловой 
скорости двигателя внутреннего сгорания (дизеля) 
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Численные значения параметров передаточных функций: 
k1 = 10; k1 = 2; k2 = 10; k3 = 0,1; k3 = 0,9; k3+k3 = 1; k4= 5;  T1 = 3 c; T2 = 
0,1 c;  T2 = 0,2 c; T4 = 0,1 с; T4 =1 c. 

При этом всегда должно выполняться условие k3+ k3=1. 
 
Порядок выполнения работы: 
1. Составить в обозначениях Simulink структурную схему САР на 

ПЭВМ. 
2. Сформировать управляющее единичное ступенчатое воздействие 

Xзад = 1(t) и возмущающее единичное ступенчатое воздействие MH = 1(t). 
Управляющее Xзад = 1(t) и возмущающее MH = 1(t) воздействия совмест-
но задавать в структурной схеме из одного источника сигнала Constant. 

3. Получить переходную (временную) характеристику системы 
по управляющему Xзад = 1(t) и возмущающему MH = 1(t) воздействиям 
при заданных значениях параметров передаточных функций. Опреде-
лить показатели качества переходного процесса. 

4. Для заданных численных значений параметров передаточных 
функций построить ЛАХ, ЛФХ и АФЧХ для разомкнутой системы по 
управляющему Xзад = 1(t) и возмущающему MH = 1(t) воздействиям. 
Определить запасы устойчивости по амплитуде и фазе. 

5. Провести исследование САР, варьируя параметры k3 (при усло-
вии k3+k3=1) и T4, согласно табл. 10 получить численные значения по-
казателей качества переходного процесса tпп = f(k3;T4) и σ = f(k3;T4) и за-
пасов устойчивости по амплитуде и фазе L = f(k3;T4) и  = f(k3;T4). 

6. Построить графики полученных численных зависимостей tпп = 
= f(k3;T4); σ = f(k3;T4); L = f(k3;T4) и  = f(k3;T4). 

7. Методом интерполяции найти рациональные значения пара-
метров k3 и T4 для переходного процесса и устойчивости САР. 

 
Содержание отчета: 
1. Функциональная схема САР угловой скорости двигателя внут-

реннего сгорания (дизеля). 
2. Cтруктурная схема САР угловой скорости двигателя внутрен-

него сгорания (дизеля). 
3. Cтруктурная схема САР угловой скорости двигателя внутрен-

него сгорания (дизеля) в обозначениях Simulink. 
4. Переходная (временная) характеристика САР по управляюще-

му Xзад = 1(t) и возмущающему MH = 1(t) воздействиям. Численные 
значения показателей качества переходных процессов. 
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5. ЛАХ, ЛФХ и АФЧХ разомкнутой САР угловой скорости дви-
гателя внутреннего сгорания (дизеля) для заданных численных значе-
ний параметров передаточных функций. Численные значения запасов 
устойчивости по амплитуде и фазе. 

6. Численные значения и графики функциональных зависимостей 
tпп = f(k3;T4); σ = f(k3;T4); L = f(k3;T4) и  = f(k3;T4). 

7. Рациональные значения коэффициентов k3 и T4. 
 

Контрольные вопросы 
 

1. Объяснить работу САР с внутренней изодромной обратной 
связью по рис. 21. 

2. Объяснить принцип работы катаракта. 
3. Какими показателями (критериями) характеризуется качество 

переходного процесса? 
4. Численные значения показателей качества переходных 

процессов по управляющему Xзад = 1(t) и возмущающему MH = 1(t) 
воздействиям. 

5. Как влияет изменение МН на Х1? 
6. Как находятся рациональные значения k3 и T4? 
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Лабораторная работа № 6 
 

ИССЛЕДОВАНИЕ НЕЛИНЕЙНОЙ СИСТЕМЫ 
АВТОМАТИЧЕСКОГО РЕГУЛИРОВАНИЯ 

 
Цель работы  исследовать нелинейную систему автоматическо-

го регулирования. 
 
Устройство системы. На рис. 23 изображена функциональная 

схема САР температуры. В состав нелинейной САР входят наряду с 
объектом регулирования ОР следующие технические средства авто-
матизации (см. рис. 1): ЧЭ – чувствительный элемент (измерительный 
мост с термометром сопротивления); ПР – поляризованное реле (уси-
литель); Д – двигатель; ОВ – обмотки возбуждения двигателя; Р – ре-
дуктор; РО – регулирующий орган (заслонка); ПОС – потенциометр 
обратной связи. 

 
Работа системы: Объектом регулирования ОР в рассматривае-

мой САР является сушильная камера. Регулируемый параметр – тем-
пература и2 греющего агента, которая устанавливается поворачиваю-
щейся заслонкой, приводимой в движение исполнительным механиз-
мом (электродвигателем с редуктором). Регулирующий орган РО – 
заслонка изменяет соотношение между количеством холодного воз-
духа и горячего газа. 

Температура теплоносителя – смеси воздуха и газа  измеряется 
термометром сопротивления, являющимся в системе чувствительным 
элементом ЧЭ. Измерительный мост является неуравновешенным. 
Равновесие моста характеризуется отсутствием напряжения и тока на 
измерительной диагонали. Всякое изменение сопротивления ЧЭ вы-
водит мост из равновесия, т.е. по диагонали моста потечет ток. 

Для усиления мощности выходного сигнала в системе использу-
ется усилитель – поляризованное реле ПР, управляющее направлени-
ем вращения электродвигателя Д. Если ток в управляющей обмотке 
ω1 отсутствует, то якорь находится в среднем, нейтральном положе-
нии, так как он с одинаковой силой притягивается как к левому, так и 
к правому положительному наконечнику. В этом положении контак-
ты реле разомкнуты. При появлении тока в управляющей обмотке 
якорь притягивается влево или вправо, в зависимости от направления 
тока. Поляризованное реле является трехпозиционным (замкнут ле-
вый контакт – оба контакта разомкнуты – замкнут правый контакт). 
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На рис. 24 представлена статическая характеристика поляризо-

ванного реле. 

 
Параметры, необходимые для математического описания системы: 
 постоянная времени объекта Т0, с; 
 коэффициент усиления объекта и регулирующего органа k0, 

град/рад; 
 коэффициент усиления чувствительного элемента k1, АВ/град; 
 коэффициент усиления двигателя k2, рад/(Вс); 

Рис. 24. Статическая характеристика поляризованного реле 
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Рис. 23. Функциональная схема системы автоматического 
регулирования температуры 
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 передаточное отношение редуктора i; 
 коэффициент усиления цепи обратной связи kос, АВ/рад; 
 ампер-витки срабатывания реле аωср, АВ; 
 максимальное напряжение на выходе релейного усилителя Umax, B. 

 
Составление уравнений элементов системы 

 
Для заданной принципиальной схемы составим уравнения звень-

ев системы в операторной форме (p – оператор Лапласа). 
Уравнение регулируемого объекта 

(T0 p + 1)·θ2 = k0φ, (7.1) 
где θ2 – фактическое значение температуры объекта; φ – угол поворо-
та регулирующего органа. 

Уравнение чувствительного элемента 
аω1 = k1 θ, (7.2) 

где θ – ошибка рассогласования системы, θ = θ1  θ2; θ1 – заданное 
значение температуры объекта. 

Уравнение релейного усилителя 
U = F(аω); (7.3) 

где аω = аω1 – аωoc; F(аω) – нелинейная функция, заданная статиче-
ской характеристикой (рис. 24). 
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 (7.4) 

Уравнение двигателя постоянного тока 
p·α = k2U, (7.5) 

где α – угол поворота вала двигателя. 
 
Уравнение редуктора 

φ =k3·α, (7.6) 
где k3 =l/i – коэффициент передачи редуктора. 

Уравнение цепи обратной связи 
аωoc = kосφ, (7.7) 

где аωoc – ампер-витки обмотки обратной связи. 
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По уравнениям (7.1)  (7.7) составить передаточные функции 
звеньев САР. 

 
Составление структурной схемы САР 

 
Структурная схема САР температуры изображена на рис. 25. 
 

 
 

Таблица 11 
Значения исследуемых параметров 

Данные 
Номер варианта 

1 2 3 4 5 6 7 8 9 10 

Т0, с 0,5 5 10 15 20 1 0,8 2 12 0,1 

k0, град/рад 10 15 20 25 30 35 5 12 18 8 

k1, АВ/град 0,3 0,4 0,5 0,2 0,25 0,35 0,6 0,7 0,8 0,9 

k2, рад/(В∙с) 2 1 3 4 2,5 1,5 3,5 4,5 5 5,5 

i 800 700 900 500 100 120 110 750 850 950 

kос·10-3, АВ/рад 2,5 3,0 3,5 4,0 4,5 1,0 1,5 5,0 5,5 6,0 

аωср, АВ 0,5 0,4 0,3 0,6 0,7 0,8 0,55 0,65 0,45 0,75 

Umах, В 100 110 120 130 125 100 110 120 130 125 
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Рис. 25. Структурно-математическая схема системы 
автоматического регулирования температуры 
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Варианты заданий представлены в табл. 11. Задающее воздейст-
вие, т.к. имеется зона нечувствительности, формируется из условия 

θ1 ≥ (1,1 аωcp)/k1. (7.8) 
Исследование переходных характеристик САР для заданных па-

раметров проводить при помощи блока электронного осциллографа 
«Scope». Исследование фазовых траекторий регулируемого параметра 
проводить при помощи блока «XY Graph», на вход «X» которого по-
дается амплитуда исследуемого сигнала, а на вход «Y»  скорость 
сигнала (дифференциал). 

Статическая характеристика поляризованного реле в Simulink 
реализуется за счет последовательного соединения блоков «Dead 
zone», «Sign» и «Gain». В блок «Dead zone» вводятся значения ампер-
витков срабатывания реле, а в «Gain» – значения Umax. 

 
Порядок выполнения работы: 
1. Изучить работу САР температуры по рис. 23. 
2. Рассмотреть статическую характеристику поляризованного ре-

ле по рис. 24. 
3. Изучить уравнения элементов САР. 
4. Вывести передаточные функции линейных элементов САР. 
5. Изучить структурную схему САР. 
6. По численным значениям параметров элементов САР для своего 

варианта (см. табл. 11) вычислить параметры передаточных функций. 
7. Составить модель САР в Simulink. 
8. Получить переходные процессы параметров САР, указанных в 

задании. 
9. Получить фазовую траекторию регулируемого параметра. 
10. Оценить качество регулирования: θ2_уст, tпп, статическую 

ошибку ст. 
 
Содержание отчета: 
1. Схема САР температуры. 
2. Структурная схема САР температуры. 
3. Структурная схема САР температуры в обозначениях Simulink. 
4. Численные значения параметров элементов САР и параметров 

передаточных функций. 
5. Переходные (временные) характеристики заданных параметров 

САР. 
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6. Фазовая траектория регулируемого параметра. 
7. Выводы по устойчивости и качеству регулирования САР: θ2уст, 

tпп, статическая ошибка ст. 
 

Контрольные вопросы 

1. В чем отличие линейных и нелинейных САР? 
2. Какими параметрами характеризуется нелинейный элемент? 
3. Что такое переходная характеристика? 
4. В чем особенность подачи ступенчатого сигнала на нелиней-

ную систему? 
5. Из каких соображений выбирается коэффициент передачи чув-

ствительного элемента k1? 
6. Что такое фазовая траектория? 
7. Как реализуется в Simulink релейная характеристика с зоной 

нечувствительности? 
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